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         THE ACROBAT EXCHANGE TOUR

This tour demonstrates the features of the Acrobat Exchange

program. For more information on a feature and for information

on Acrobat software, see the on-line guide provided with this 

program. 


If you make a mistake, click the Go Back button in 

the tool bar at the top of the screen to retrace your steps.

 

You can also click the Go Forward button to undo Go Back.


Try this now; then continue the tour.


Click the arrow button at the bottom of the 

screen to continue.
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If a document contains bookmarks, you can use the 

bookmarks to jump to pre-defined destinations in the 

document.

Click the Bookmark button in the tool bar.
 

The overview area at the left of the window displays all of the 

bookmarks for this tour. If you get lost during the tour, 

double-click the page icon next to the name of a tour topic 

to jump to that topic.


Double-click the page icon to the left of the bookmark 

named “Zooming” to jump to the next topic in the tour.
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LEVEL

TWO

This is an office map. The names and phone 

numbers are too small to read at this magnification 

level. By zooming in you can read the names and

numbers.


Click the zoom-in tool in the tool bar.


Place the magnifying glass over the desk in 

the lobby and click the mouse button.

3

Clicking the zoom-in tool doubled the magnification.


Now hold down the mouse button and drag a 

marquee around the dotted rectangle above.

4

The screen contains the area

within the rectangle.5
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GROUP NO.   											 BILLING UNIT NO.   SOCIAL SECURITY NO.                EMPLOYER





NAME OF EMPLOYEE                                                                                                                                                               	                                SEX:                            BIRTHDATE

                      

                                                                                                                                                                                                                            

ADDRESS OF EMPLOYEE: NO. & STREET                                                                   CITY                                                                                     STATE                        ZIP





TELEPHONE NO.                                                                              DATE YOU LAST WORKED                                                HAS YOUR EMPLOYMENT TERMINATED?                  IF YES, WHEN?



                                                                                                                                                                                                                                          






COMPLETE   


LINES 5,6 & 7


IF THIS CLAIM IS 


FOR ONE OF 


YOUR DEPENDENTS

NAME OF DEPENDENT                                                                                                                  SEX                          BIRTHDATE               RELATIONSHIP


                                                                                                                                                                   M             F







ADDRESS OF DEPENDENT                              SS# OF DEPENDENT               SCHOOL/EMPLOYER (if any) of Dependent                 ADDRESS OF SCHOOL











MARRIED             WIDOWED



SINGLE                DIVORCED M            F             

YES          NO

IF MARRIED, YOUR SPOUSE'S FIRST NAME       SPOUSE'S DATE OF BIRTH      NAME AND ADDRESS OF SPOUSE'S EMPLOYER                                              SS# OF SPOUSE



IS SPOUSE EMPLOYED?        YES           NO     




MARRIED            WIDOWED


SINGLE               DIVORCED

IS PATIENT COVERED                         INSURANCE COMPANY                                                                EMPLOYER                                                                      POLICY NO. OR I.D. NO. 

BY ANOTHER PLAN?

YES


NO

YES


NO

IS CONDITION DUE                              IF YES, WAS THE INJURY CAUSED BY THE ACT OR                                                           PLACE OF ACCIDENT                 DATE OF ACCIDENT

TO  ACCIDENTAL                                 OMISSION OF A PERSON OTHER THAN YOURSELF?

INJURY?

YES           NO AUTO                  WORK


HOME                 OTHER 

OPTIONAL (see Instr. #3) I hereby authorize payment to the below named dentist medical                        I authorize release to or by Insurance Company of any medical or

and/or dental benefits otherwise payable to me, but not to exceed the charges shown below.                      dental benefit information rquired to process my claim.

I realize that I am responsible for any charges not covered by this authorization.                                          A photocopy of this authorization may be honored.

EMPLOYEE'S SIGNATURE                                                                                           DATE                       SIGNATURE (Patient or Parent if Minor)                                                                    DATE                        

ARE YOU A PARTICIPANT IN THE HEALTH CARE REIMBURSEMENT ACCOUNT:          YES           NO



IF YES, YOU MAY ELECT TO HAVE ANY EXPENSES WHICH ARE NOT COVERED, OR ONLY PARTIALLY COVERED BY YOUR MEDICAL PLAN

AUTOMATICALLY PROCESSED UNDER THE REIMBURSEMENT ACCOUNT BY CHECKING THE BOX BELOW. 

I HEREBY REQUEST THAT ANY UNREIMBURSED PORTION OF THE CLAIM BE PROCESSED UNDER MY HEALTH CARE REIMBURSEMENT

ACCOUNT. I CERTIFY THIS HEALTH CARE EXPENSE HAS NOT BEEN REIMBERSED OR IS NOT REIMBURSABLE UNDER ANY OTHER  

EMPLOYER SPONSORED HEALTH CARE PLAN.






EMPLOYEE SIGNATURE                                                                                                                                                               DATE

Unreimbursed amounts approved 

for payment under the FSA

DED:


COINS:


MISC:


INCURRAL DATES from                   thru


EXAM.AUTH

NAME OF DENTIST                                                    NAME OF PATIENT      




MAILING ADDRESS OF DENTIST





CITY, STATE, ZIP





DENTIST'S SOC. SEC. OR T.I.N.               DENTIST'S LICENSE NO.           DENTIST'S PHONE NO.

Is Treatment Result       No  Yes   If yes, enter brief description and dates

Of Occupational 

Illness or Injury?


Is Treatment Result

Of Auto Accident?

Other Accident?

Are any Services

Covered By Another

Plan?

If Prosthesis, is This 

Initial Placement? 

Is Treatment For 

Orthodontics?

(If no, Reason for Replacement)    Date of Prior Placement

If Services                  Date Appliances          Mos. Treatment

Already                       Placed                         Remaining

Commenced,

Enter

First Visit Date           Place     Date of Treatment       Radiographs or              No  Yes            How

Current Series           Office   Hosp.     ECF    Other   Models Enclosed?                                Many?

PLEASE PLOT WORK                                            EXAMINATION AND TREATMENT RECORD - LIST IN ORDER FROM TOOTH NO. 1 THROUGH TOOTH NO. 32                              FOR INS. CO.

                                                                                                                                                                                                                     USE ONLY

Tooth 

# Or          SURFACE

Letter

DESCRIPTION OF SERVICES

(Including X-rays, Prophylaxis, Materials Used, Etc.

DATE SERVICE 

PERFORMED





MO.   DAY   YR

ADA

Procedure


Code

ACTUAL 

FEE


BEING 

CHARGED

I HEREBY CERTIFY THAT THE SERVICES LISTED ABOVE ARE MY NORMAL FEES FOR THESE


SERVICES FOR ALL PATIENTS AND           WILL BE              HAVE BEEN PERFORMED





TOTAL

MARK MISSING TEETH WITH

AN "X" AND INDICATE BELOW

DATE EXTRACTED OR LOST. DENTIST'S SIGNATURE                                                                                                                                        DATE

FACIAL

LINGUAL

LINGUAL

FACIAL

RIGHT                                             LEFT
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REIMBURSEMENT ACCOUNT AUTHORIZATION                                            FOR CLAIM EXAMINER USE

DENTIST

This is a dental form at its 

actual size (100%).



Click the Actual Size, 

Fit Page in Window, 

and Fit Width in Window 

buttons in the tool bar to 

see how they change 

the page view. 
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Streamline PC 5/25/93 14:48 c3.exch.paging.frame

 

First master page, SS template

 

The Adobe Streamline program provides three conver sion methods: Outline, 
Centerline, and Line Recognition. You can use the Outline conversion method with 
any kind of image (black-and-white, grayscale,  or color). You can use the Center-
line, Line Recognition, and Reverse Image conver sion methods with a black-and-
white image, or with a grayscale or color image while the Number of Colors (in the 
Color Setup dialog box) is set to two.

The Outline method converts images that contain filled areas and lines that vary in 
weight, such as clip ar t or hand-drawn images. The Centerline method converts 
images that contain consistent line weights and no filled areas, such as schematics. 
The Line Recognition method converts images that contain horiz ontal and vertical 
lines, such as forms and certain charts and graphs.

 

Image suited for Outline Image suited for Centerline Image suited for Line
conversion conversion Recognition conversion

 

You can mix conversion methods for images that combine features suited for more 
than one method. For example, you can combine the Outline and Centerline 
methods to convert images that have a mix of consistent line weights and filled 
areas; or you can combine the Centerline and Line Recognition methods to convert 
images with horizontal, vertical, slanted, and curved lines.

 

Image suited for Outline and Centerline Image suited for Centerline and Line
conversion Recognition conversion

1


2


3


4


5

DESCRIPTION UNIT PITEM NUMBERQUANTITY

Name


Street


City/State/Zip


Phone

Name


Street


City/State/Zip


Phone

ORDERED BY SHIP TO

 

Chapter 3: 

 

Using Streamline to Convert an Image

   

This is the first page of a chapter in a software

user guide.




The Next Page button in the tool bar takes you

to the top of the next page.  You can also use the

Arrow keys on your keyboard.



Press the Down Arrow (or Right Arrow) 

key now.

7
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Streamline PC 5/25/93 14:48 c3.exch.paging.frame

 

Left2 master page, SS template

 

The Conversion Method dialog box lets you choose conver sion methods, set 
various line options, or reverse the bitmapped image. Unless you plan to use the 
default conversion settings (the Outline conversion method with the Noise Level set 
to eight pixels), you should set your conversion options before beginning the 
conversion.

 

 

 

Converting images using the Outline method

 

The Outline conversion method converts images by tracing an outline of each 
element in the image and filling it with black, white, a color, or some value or tint 
specified in the Paint Style dialog box. (The Paint Style dialog box is described in 
Chapter 1, “Basic Concepts.”) This conversion method is designed to convert 
images that contain more than two colors or inconsistent line weights and filled 
areas, such as illustrative, graphic design, and non-technical line art images. 

 

Images suited for Outline conversion

    

This is the top of the next page.



The Page Down and Page Up keys page through 

a document one screenfull at a time.



Press the Page Down key. (If you are using a 

Macintosh without a Page Down key, press 

Return for Page Down and Shift-Return for

Page Up.)

8

7 of 24

Page Down has taken you to the bottom of the page.



Use the Go To Page feature to jump to a page.



Click the page number box at the bottom of the 

window to display the Go To Page dialog box.







Enter 12 and click OK. 

9
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Streamline PC 5/25/93 14:48 c3.exch.paging.frame

 

Right2 master page, SS template

 

Images converted using the Outline method contain only filled areas. Lines are 
converted to filled paths and circles are converted to layered areas. The following 
examples illustrate how the figures of an outlined image appear when you choose 
Preview Illustration from the View menu.

 

Preview Illustration Artwork Only

 

Compare the above examples. The circle is not a stroked line, but is created with two 
filled areas placed on top of each other. To edit these images, you must edit the 
anchor points surrounding each of the filled areas. An 

 

anchor point

 

 is the point along 
a path of a converted image at which a segment star ts or ends.

 

Eliminating noise in scanned bitmapped images

 

When you select the Outline conversion method, the Noise Level option becomes 
available. Use this option to eliminate the stray pixels (noise) introduced by scan-
ning a poor-quality original.

You can select a noise level setting between 0 and 1000; the default setting is 8. 
Areas that are smaller than the noise level setting are ignored when the image is 
converted. For example, if the noise level is set at 8, the program ignores any 
elements of an image that are composed of eight or fewer pixels. 

white fill

black fill
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Streamline PC 5/25/93 14:48 c3.exch.paging.frame

 

Left2 master page, SS template

 

Notice in the following examples how the var ious noise level settings change the 
level of detail in the image:

 

Noise level: 0 pixels Noise level: 8 pixels

Noise level: 100 pixels

 

You can increase the noise level setting if you want the Adobe Streamline program 
to ignore larger pixel areas, or y ou can decrease the setting to capture all the small 
details of a bitmapped image. For very small images, reduce the noise level setting 
to retain the details of the image.

This option is available only when you select the Outline conversion method. If you 
combine the Outline and Centerline methods, the noise level setting applies to the 
areas that will be outlined. You can use additional program options to control the 
type of lines used to outline the converted image and to control how closely the 
converted image matches the bitmapped image. For more information, see “Using 
other conversion options” later in this chapter.

 

NOTE: To eliminate noise outside of the image area, use the eraser tool to erase 
those pixels before converting the image. You can also edit the image using the 
pencil or line tool before converting the image. For more information about these 
tools, see Chapter 2, “Preparing an Image for Conversion.”

This is the top of page 9 and the end of the

paging demonstration. 11
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Streamline PC 5/25/93 14:48 c3.exch.paging.frame

 

Right master page, SS template

 

Converting images using the Centerline method

 

The Centerline conversion method converts bitmapped images by locating the center 
of each line and creating a stroked path. This conversion method affects only black-
and-white (not grayscale) images, and is designed to convert technical images and 
other images that contain consistent line weights and no filled areas.

Images converted using the Centerline method contain only stroked paths. The 
following examples illustrate how the figures of a centerlined image appear when 
you choose Preview Illustration from the View menu. The circ le and the line are 
created as stroked lines.

Bitmapped images with lines less than 6 points in weight are suitable for converting 
with the Centerline conver sion method. If an image contains lines heavier than 6 
points, combine the Centerline and Outline conversion methods. If you do not have 
a copy of the original scanned image to measure the heaviest line weight, you should 
print the bitmapped image. Keep in mind that very thin lines may not print at their 
true weight, depending on the resolution of the printer.

The following chart compares various units of measurement:

 

Specifying the number of steps to find the center of lines

 

To draw a stroked path and maintain a minimum number of junction points (where 
two or more lines intersect), the Adobe Streamline program must approximate the 
center of the line. Decreasing the number of junction points makes the image easier 
to edit in your graphics application, and reduces the final file size. 

The following illustration shows traced lines as they appear with a template behind 
them in the Adobe Illustrator program (enlarged view). Notice how the Adobe 
Streamline program is able to approxima te the center of the lines.

To approximate the center of lines, use the Number of Steps option to create lines 
that are one pixel wide as described below. One-pixel lines will have fewer junction 
points than lines that are two or more pixels wide. The pixel width approximated by 
the Number of Steps option does not affect the final point size of lines.

For each step you select, the program strips a layer of pixels from each edge of lines 
in the image to locate the center of the lines; the higher the number of steps you 
specify, the more any irregular pixels in the lines will be eliminated.
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Streamline PC 5/25/93 14:48 c3.exch.paging.frame

 

Left master page, SS template

 

During the conversion process, the program displa ys small circles at all junction 
points. If the number of junction circles seems excessive (appearing in places other 
than true junction points), try increasing the number of steps until junction circles 
appear only at true junction points. You can also use the node deletion tool or the 
Smooth Path command to reduce the number of anchor points in the converted 
image as described in Chapter 4, “Working with a Converted Image.”

The recommended Number of Steps setting depends on the resolution of the original 
bitmapped image and the point size of the heaviest line in the image. Assuming an 
image resolution of at least 300 dpi, the number of steps you select should be equal 
to or greater than the point size of the heaviest line in the bitmapped image so that 
all lines in the image will be approximated at one pixel wide. For example, if the 
heaviest line in a 300 dpi image is 3 points, set the number of steps to at least 3 (the 
default).

The following chart shows some gener al guidelines for using the Number of Steps 
option at various image resolutions. Use the suggested settings as approximate 
guides. For the best results, convert your bitmapped image at var ious settings until 
you find the most appropriate setting. 

 

NOTE: In general, the higher the number of steps you specify, the more irregular 
pixels are eliminated. Specifying too many steps, however, will shorten lines that 
don’t meet another line or object. To conver t the small details of a bitmapped 
line, it is best to use the minimum required n umber of steps.

 

If your bitmapped imag e contains lines heavier than 6 points, combine the Center-
line and Outline conversion methods, and set the Number of Steps option to 6. By 
combining these two methods, lines that ar e less than or equal to 6 points will be 
converted into stroked paths by the Centerline method, and lines that are greater than 
6 points will be converted into filled areas by the Outline method.

 

NOTE: Because you may have to adjust the number of steps for different image 
resolutions, when converting a batch of images, make sure that all the images in 
the Files to Process list in the Batch Select dialog box have the same resolution.

 

Converting white lines 

 

Normally, the Adobe Streamline program recognizes only blac k lines on a white 
background. If you want to convert an image that uses w hite lines on a black back-
ground (for example, a blueprint),  select the White Lines option. When you select 
this option, the program reverses the w hite lines to black, converts the image, then 
reverses the lines back to white before saving the converted image. 

 

Blueprint image with white lines

c3.exch.paging.frame  Page 29  Black  Tuesday, May 25, 1993 3:41 PM



 

Chapter 3: 

 

Using Streamline to Converting an Image

 

30

 

Streamline PC 5/25/93 14:48 c3.exch.paging.frame

 

Right master page, SS template

 

Selecting a uniform line weight

 

The Uniform Line Weight option allows you to select a specific line weight for the 
converted image. If you are combining the Centerline and Outline conversion 
methods, only lines that are centerlined are affected. You can select a line weight of 
0 to 12 points; the default line weight is 1 point.

If your bitmapped imag e contains lines of varying weights,  deselect the Uniform 
Line Weight option to reproduce results as close to the original as possible. When 
the Uniform Line Weight option is deselected, the program measures the line weight 
of each line segment and averages the line weight over the entire path. If lines with 
different weights intersect or connect, the program may average the two line weights 
together and convert both lines to a single line weight.

If your bitmapped image contains lines with varying line weights and the lines inter-
sect, you may want to convert the image using the Uniform Line Weight option, and 
then change the stroke weight in the Paint Style dialog box after converting the 
image. For more information about changing the stroke weight, see “Using the Paint 
Style dialog box” in Chapter 4.

 

TIP: If you use the Uniform Line Weight option and the lines of the bitmapped 
image vary in weight by more than 1 point, set the Number of Steps option to the 
heaviest line weight. 

 

Creating separate shapes

 

The Separate Shapes option determines how the Adobe Streamline program 
constructs paths surrounding adjacent areas. If you choose this option, each area in 
the bitmapped image that is completely surrounded by a stroked line will be 
surrounded by a unique path in the converted image. If a single line separates two 
enclosed areas, the line will be converted twice—once for each path. Using the 
Separate Shapes option lets you edit an individual shape in an image without 
disturbing its surrounding shapes. 

This is the top of page 12.



You can also use the vertical scroll bar at the right

of the window to scroll to a page.



Drag the scroll box up until page 9 appears 

to the left of the scroll bar. Then release the 

mouse button.

Page 9

10
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This is the first page of an Acrobat phone list and

office map document. Each person's name is a 

“link button” that is linked to the person's office 

on the map.



Click anywhere on Marvin Dolansky's name

in the lower right corner of this page.
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A1-03

A1-05

A1-30A1-32

A1-33

A1-34

A1-38A1-40

A1-39A1-41

A1-43

A1-45

A1-46A1-48

A1-47

A1-31

A1-07

A1-10

A1-11

A1-12

A1-13

A1-20

A1-21

A1-22

A1-23

A1-24A1-29

A1-16

A1-18

A1-19

A1-61A1-67

A1-68

A1-70 A1-66

A1-81

A1-83

A1-88

A1-86 A1-82

A1-85

A1-87

The link shows a magnified view of Marvin's 

office.


To see where Marvin's office is on the floor, 

select the zoom box at the bottom of the

screen and choose 200%.

50%

100%

200%
400%

800%


Other...

400%

This is the office map shown at 200%.
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Now you will create a link between a person's name in the phone list and the 

corresponding office on the office map.



Click the link tool in the tool bar. Drag to draw a box around the name 

“Donnas.”  (The name is at the top of the list.) 



When the Create Link dialog box appears, click the Next Page button 

in the tool bar. 

If you want to test the 

link, click Albert 

Donnas's name once and 

use the Go Back button 

to return to this screen.

 

Then continue 

with the tour. 
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LEVEL

TWO

Albert Donnas's office is in the lower right

corner of the map.



Select the zoom-in tool and drag a marquee 

around the dotted rectangle in the lower right 

section of the map.

Click OK in the Create Link dialog box to 

create the link.
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Left2 master page, SS template

 

Combining the Outline and Centerline methods

 

You can combine the Outline and Centerline conversion methods to convert images 
that use both filled areas and consistent line weights. Keep in mind that the Center-
line method affects only black-and-white and two-color images.

 

Images suited for Centerline and Outline conversion

The following examples show how the elements of an image converted by 
combining the Outline and Centerline methods appear when you choose Preview 
Illustration from the View menu. The circle and the line are created as lines, and the 
boat within the circle is created as a filled area.

Preview Illustration Artwork Only

black

stroke

black fill

 

This is a page of a software user guide. Suppose you are searching 

for a definition or an example of the word “stroke” (a type of line 

weight). 



1  Click the find tool in the tool bar.



2  Enter the word “stroke” and click the Match Whole Word 

    Only option. This option tells the program not to find words 

    that contain the word you are searching for (such as “stroked” 

    or “strokes”).



3  Click the Find button. The Find dialog box closes, and the 

    word “stroke” is highlighted in the illustration.



4  Press Ctrl+G (with Windows) or Command-G (on the

    Macintosh) to find the next occurrence of the word.
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Streamline PC 6/3/93 15:44 EXfind.frame

 

Right2 master page, SS template

Combining the Centerline and Line Recognition methods
You can combine the Centerline and Line Recognition conversion methods to 
convert images that use horizontal, vertical, slanted, and curved lines. 

Images suited for Centerline and Line Recognition conversion

When you convert an image combining the Centerline and Line Recognition 
methods, horizontal and vertical lines are converted first using the Line Recognition 
method, then a second pass converts curved lines using the Centerline method. It 
may appear on your screen as though the horizontal and vertical lines have been 
centerlined also, but such is not the case, as you will see when you print the image 

Centerline and Line Recognition methods appear when you choose Preview Illus-
tration from the View menu. Note that the circle and the line are created as lines.

Preview Illustration Artwork Only with all paths selected

black 

stroke

 

The next occurrence of the word “stroke” is displayed. 20
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This is an Acrobat phone list. Suppose that Albert Donnas's phone number 

changed and you wanted to add his new number to this list.



1  Click the note tool.



2  Place the cross hair beneath Albert Donnas's name and click.



3  Type Albert's new number in the note window (for example, 5555).



4  Double-click the upper left corner of the note box to close it. (On the 

    Macintosh just click once.)  Then drag the note icon to the left of Albert's 

    name.  Double-click the note icon to reopen the note window.

� 
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Streamline PC 6/4/93 13:37 EXbkmks.frame

 

First master page, SS template

 

The Adobe Streamline program provides three conver sion methods: Outline, 
Centerline, and Line Recognition. You can use the Outline conversion method with 
any kind of image (black-and-white, grayscale,  or color). You can use the Center-
line, Line Recognition, and Reverse Image conver sion methods with a black-and-
white image, or with a grayscale or color image while the Number of Colors (in the 
Color Setup dialog box) is set to two.

The Outline method converts images that contain filled areas and lines that vary in 
weight, such as clip ar t or hand-drawn images. The Centerline method converts 
images that contain consistent line weights and no filled areas, such as schematics. 
The Line Recognition method converts images that contain horiz ontal and vertical 
lines, such as forms and certain charts and graphs.

 

Image suited for Outline Image suited for Centerline Image suited for Line
conversion conversion Recognition conversion

You can mix conversion methods for images that combine features suited for more 
than one method. For example, you can combine the Outline and Centerline 
methods to convert images that have a mix of consistent line weights and filled 
areas; or you can combine the Centerline and Line Recognition methods to convert 
images with horizontal, vertical, slanted, and curved lines.

Image suited for Outline and Centerline Image suited for Centerline and Line
conversion Recognition conversion

 

1


2


3


4


5

DESCRIPTION UNIT PITEM NUMBERQUANTITY

Name


Street


City/State/Zip


Phone

Name


Street


City/State/Zip


Phone

ORDERED BY SHIP TO

Chapter 3: 

 

Using Streamline to Convert an Image

This is the first page of a chapter in a software

user guide. You will add your own bookmarks 

to mark the first few sections of this chapter.


1  Choose the Bookmarks command from the 

    Edit menu and choose New from the 

    submenu.  A new bookmark, named 

    “Untitled,” is added to the end of the 

    bookmark list.


2  Make sure that the bookmark is highlighted

    and type “Using Streamline.”  


3  Click the Next Page button in the tool bar.
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Streamline PC 6/4/93 13:37 EXbkmks.frame

 

Left2 master page, SS template

The Conversion Method dialog box lets you choose conver sion methods, set 
various line options, or reverse the bitmapped image. Unless you plan to use the 
default conversion settings (the Outline conversion method with the Noise Level set 
to eight pixels), you should set your conversion options before beginning the 
conversion.

 

Converting images using the Outline method
The Outline conversion method converts images by tracing an outline of each 
element in the image and filling it with black, white, a color, or some value or tint 
specified in the Paint Style dialog box. (The Paint Style dialog box is described in 
Chapter 1, “Basic Concepts.”) This conversion method is designed to convert 
images that contain more than two colors or inconsistent line weights and filled 
areas, such as illustrative, graphic design, and non-technical line art images. 

Images suited for Outline conversion

This page contains the first section in the chapter. 


To scroll to the bottom of the page, click 

anywhere beneath the scroll box in the vertical 

scroll bar.

23

With the page view now centered over the

section title, we can add the bookmark that

will jump to this view.


1  Press Ctrl+B (with Windows) or 

    Command-B (on the Macintosh) to add a 

    new bookmark.  Name the new bookmark

    “Outline Method.”

2  Choose Bookmarks from the Edit menu and

    Move Right from the submenu to indent the 

    new bookmark.

3  Press the Down Arrow key to go to the 

    next page.

24
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Streamline PC 6/4/93 13:37 EXbkmks.frame

 

Right2 master page, SS template

Images converted using the Outline method contain only filled areas. Lines are 
converted to filled paths and circles are converted to layered areas. The following 
examples illustrate how the figures of an outlined image appear when you choose 
Preview Illustration from the View menu.

Preview Illustration Artwork Only

Compare the above examples. The circle is not a stroked line, but is created with two 
filled areas placed on top of each other. To edit these images, you must edit the 
anchor points surrounding each of the filled areas. An anchor point  is the point along 
a path of a converted image at which a segment star ts or ends.

Eliminating noise in scanned bitmapped images

When you select the Outline conversion method, the Noise Level option becomes 
available. Use this option to eliminate the stray pixels (noise) introduced by scan-
ning a poor-quality original.

You can select a noise level setting between 0 and 1000; the default setting is 8. 
Areas that are smaller than the noise level setting are ignored when the image is 
converted. For example, if the noise level is set at 8, the program ignores any 
elements of an image that are composed of eight or fewer pixels. 

white fill

black fill

This page contains a subsection of the Outline

Method section.


Click anywhere beneath the scroll box in 

the vertical scroll bar to scroll to the bottom 

of the page.

25

1  Press Ctrl+B (with Windows) or Command-B 

    (on the Macintosh) to add a new bookmark. 

    Name the new bookmark “Noise.”

2  Press Ctrl+Right Arrow (with Windows) or

    Command-Right Arrow (on the Macintosh) 

     to indent the new bookmark.

3  Click the triangle next to the bookmark

     “Using Streamline” to hide the subordinate

     bookmarks.  


You can use the triangles to show and hide 

subordinate bookmarks in the bookmarks list.

26



   

If a document contains thumbnails, you can use the 

thumbnails to jump to pre-defined destinations in the 

document. (A thumbnail is a miniature image of a page.)


Click the Thumbnail button in the tool bar.
 

The overview area to the left of this window displays 

thumbnails of the pages in this tour. (On some black-and-

white monitors, thumbnails may appear faded or sketchy.)


Click inside the box in the upper right corner of the 

thumbnail of page 24.
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Home Loan pymt for rate
1
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3 1
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A B C D E F G H I J K L M N O P Q
PRINCIPAL $100,000 PRINCIPAL $100,000 PRINCIPAL $150,000 PRINCIPAL $150,000 PRINCIPAL $203,150 PRINCIPAL $203,150
Term 30 Term 15 Term 30 Term 15 Term 30 Term 15

Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment
5.40% ($562) 5.40% ($812) 5.40% ($842) 5.40% ($1,218) 5.40% ($1,141) 5.40% ($1,649)
5.60% ($574) 5.60% ($861) 5.60% ($861) 5.60% ($1,234) 5.60% ($1,166) 5.60% ($1,671)
5.80% ($587) 5.80% ($880) 5.80% ($880) 5.80% ($1,250) 5.80% ($1,192) 5.80% ($1,692)
6.00% ($600) 6.00% ($899) 6.00% ($899) 6.00% ($1,266) 6.00% ($1,218) 6.00% ($1,714)
6.20% ($612) 6.20% ($919) 6.20% ($919) 6.20% ($1,282) 6.20% ($1,244) 6.20% ($1,736)
6.40% ($626) 6.40% ($938) 6.40% ($938) 6.40% ($1,298) 6.40% ($1,271) 6.40% ($1,759)
6.80% ($652) 6.80% ($978) 6.80% ($978) 6.80% ($1,332) 6.80% ($1,324) 6.80% ($1,803)
7.00% ($665) 7.00% ($998) 7.00% ($998) 7.00% ($1,348) 7.00% ($1,352) 7.00% ($1,826)
7.20% ($679) 7.20% ($1,018) 7.20% ($1,018) 7.20% ($1,365) 7.20% ($1,379) 7.20% ($1,849)
7.40% ($692) 7.40% ($1,039) 7.40% ($1,039) 7.40% ($1,382) 7.40% ($1,407) 7.40% ($1,872)
7.50% ($699) 7.50% ($1,049) 7.50% ($1,049) 7.50% ($1,391) 7.50% ($1,420) 7.50% ($1,883)
7.60% ($706) 7.60% ($1,059) 7.60% ($1,059) 7.60% ($1,399) 7.60% ($1,434) 7.60% ($1,895)
7.63% ($708) 7.63% ($1,062) 7.63% ($1,062) 7.63% ($1,401) 7.63% ($1,438) 7.63% ($1,898)
7.80% ($720) 7.80% ($1,080) 7.80% ($1,080) 7.80% ($1,416) 7.80% ($1,462) 7.80% ($1,918)
8.00% ($734) 8.00% ($1,101) 8.00% ($1,101) 8.00% ($1,433) 8.00% ($1,491) 8.00% ($1,941)
8.20% ($748) 8.20% ($1,122) 8.20% ($1,122) 8.20% ($1,451) 8.20% ($1,519) 8.20% ($1,965)
8.40% ($762) 8.40% ($1,143) 8.40% ($1,143) 8.40% ($1,468) 8.40% ($1,548) 8.40% ($1,989)
8.60% ($776) 8.60% ($1,164) 8.60% ($1,164) 8.60% ($1,486) 8.60% ($1,576) 8.60% ($2,012)
8.80% ($790) 8.80% ($1,185) 8.80% ($1,185) 8.80% ($1,504) 8.80% ($1,605) 8.80% ($2,036)
9.00% ($805) 9.00% ($1,207) 9.00% ($1,207) 9.00% ($1,521) 9.00% ($1,635) 9.00% ($2,060)
9.20% ($819) 9.20% ($1,229) 9.20% ($1,229) 9.20% ($1,539) 9.20% ($1,664) 9.20% ($2,085)
9.40% ($834) 9.40% ($1,250) 9.40% ($1,250) 9.40% ($1,557) 9.40% ($1,693) 9.40% ($2,109)
9.60% ($848) 9.60% ($1,272) 9.60% ($1,272) 9.60% ($1,575) 9.60% ($1,723) 9.60% ($2,134)
9.80% ($863) 9.80% ($1,294) 9.80% ($1,294) 9.80% ($1,594) 9.80% ($1,753) 9.80% ($2,158)

10.00% ($878) 10.00% ($1,316) 10.00% ($1,316) 10.00% ($1,612) 10.00% ($1,783) 10.00% ($2,183)
10.20% ($892) 10.20% ($1,339) 10.20% ($1,339) 10.20% ($1,630) 10.20% ($1,813) 10.20% ($2,208)
10.40% ($907) 10.40% ($1,361) 10.40% ($1,361) 10.40% ($1,649) 10.40% ($1,843) 10.40% ($2,233)
10.60% ($922) 10.60% ($1,383) 10.60% ($1,383) 10.60% ($1,667) 10.60% ($1,873) 10.60% ($2,258)
10.80% ($937) 10.80% ($1,406) 10.80% ($1,406) 10.80% ($1,686) 10.80% ($1,904) 10.80% ($2,284)
11.00% ($952) 11.00% ($1,428) 11.00% ($1,428) 11.00% ($1,705) 11.00% ($1,935) 11.00% ($2,309)
11.20% ($967) 11.20% ($1,451) 11.20% ($1,451) 11.20% ($1,724) 11.20% ($1,965) 11.20% ($2,335)
11.40% ($983) 11.40% ($1,474) 11.40% ($1,474) 11.40% ($1,743) 11.40% ($1,996) 11.40% ($2,360)
11.60% ($998) 11.60% ($1,497) 11.60% ($1,497) 11.60% ($1,762) 11.60% ($2,027) 11.60% ($2,386)
11.80% ($1,013) 11.80% ($1,520) 11.80% ($1,520) 11.80% ($1,781) 11.80% ($2,058) 11.80% ($2,412)
12.00% ($1,029) 12.00% ($1,543) 12.00% ($1,543) 12.00% ($1,800) 12.00% ($2,090) 12.00% ($2,438)
12.20% ($1,044) 12.20% ($1,566) 12.20% ($1,566) 12.20% ($1,820) 12.20% ($2,121) 12.20% ($2,464)
12.40% ($1,060) 12.40% ($1,589) 12.40% ($1,589) 12.40% ($1,839) 12.40% ($2,152) 12.40% ($2,491)
12.60% ($1,075) 12.60% ($1,613) 12.60% ($1,613) 12.60% ($1,859) 12.60% ($2,184) 12.60% ($2,517)
12.80% ($1,091) 12.80% ($1,636) 12.80% ($1,636) 12.80% ($1,878) 12.80% ($2,216) 12.80% ($2,544)
13.00% ($1,106) 13.00% ($1,659) 13.00% ($1,659) 13.00% ($1,898) 13.00% ($2,247) 13.00% ($2,570)
13.20% ($1,122) 13.20% ($1,683) 13.20% ($1,683) 13.20% ($1,918) 13.20% ($2,279) 13.20% ($2,597)
13.40% ($1,138) 13.40% ($1,706) 13.40% ($1,706) 13.40% ($1,938) 13.40% ($2,311) 13.40% ($2,624)
13.60% ($1,153) 13.60% ($1,730) 13.60% ($1,730) 13.60% ($1,957) 13.60% ($2,343) 13.60% ($2,651)
13.80% ($1,169) 13.80% ($1,754) 13.80% ($1,754) 13.80% ($1,977) 13.80% ($2,375) 13.80% ($2,678)

Page 1

This is the upper right corner of a large spreadsheet.  


Notice the gray box displayed on the thumbnail.

This box indicates the part of the page you are

viewing. You can move or resize the box to change 

the page view.  


Place the pointer over the box (the pointer 

becomes a hand) and drag the box to the 

upper left corner of the thumbnail.

You can also use the hand tool to scroll by dragging 

the page in the main window.


Click the hand tool in the tool bar. Position the

hand tool in the lower right corner of the main 

window and drag to the upper left corner of

the window. 

This is the end of the tour. 


Close the tour without saving 

changes to preserve the tour file

for new users. 

Position the pointer in the upper left corner of 

the spreadsheet thumbnail and drag to draw a 

marquee around the entire thumbnail.31
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